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The Articulate Rapid E-Learning PowerPoint Template Kit contains two PowerPoint®
template files: the Rapid E-Learning Course Template (rapid_course_template.pot)
and the Content Starter Set template (content_starter_set.pot). These templates
have been designed in conjunction with William Horton Consulting to help you quickly
and easily begin creating courses in PowerPoint® and publish them for e-learning
delivery using Articulate Presenter. Many more templates are available for purchase
at www.horton.com.

Read on to learn how to get the most from these templates.

RAPID-LEARNING COURSE TEMPLATE

The Rapid E-Learning Course Template (rapid_course_template.pot) is the basic course
template. It provides a structure you can use to quickly and easily build a course. Simply use the
slides you need and delete the rest. Replace the text and graphic placeholders with your own
content, add narration, then publish for delivery over the Web.

Organization

Here are the slides included in the template. Each slide is discussed in more detail under the
section “Individual Slides and notes.”

Course title

Your instructor

Course objectives

i . -
Topic 1 title Topic 1 preview  Topic 1 content
pppppppppp few mmme | B3 Topic2content a top-and-thi
B o - _—
Topic 2 title Topic 2 preview  Topic 2 content Topic 2 Stop-and-think
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B Topic3preview s B Topic 3 content Topic 3 Stop-andthink

Topic 3 title Topic 3 preview  Topic 3 content Topic 3 Stop-and-think

3 Course summary

Course summary

Quiz introduction

Quiz placeholder

o For more

Congratulations

The template starts out with a course title slide, course objectives, and an introduction to the
presenter. It ends with slides for a summary, a quiz introduction, a quiz placeholder, additional
references, and a congratulations slide.

In between the introductory and ending slides are sets of topic slides. Each set contains a topic
title, a topic preview, a placeholder for more detailed content, and a placeholder for a stop-and-
think activity.

&3 Topic 1 preview

that further explains

&3 Topic 1 content @ Topic 1 Stop-and-think

Replace this slide with Replace this slide with a
content slides from the thetorical question slide, a
Content Starter Set that learning game, an Articulate
communicate the ideas of QuizMaker quiz, or a

the topic. combination of activities.

.‘g Topic 1 title
£

Relevant graphic

This is the subtitle

This grouping is repeated three times. If your course has only one topic, delete the two extra sets
of topic slides. If your course has more than three topics, duplicate a set of topic slides as often
as needed.

Before you begin using the Rapid E-Learning Course Template, play the slides in Slide Show
view (F5) to see the animation effects that are built in.

If you need ideas for ways to express your instructional content, take a look at the Content
Starter Set template (content_starter_set.pot). There is more information about these content
slides later in this document.
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General instructions

There are two ways to use the Rapid E-Learning Course Template: as the basis for a new course
or as a source for slides to add to an existing course.

To use the Rapid E-Learning Course Template for a new course:
1. Open rapid_course_template.pot.

2. Save the file as your new course. Select File > Save and pick the file name for your
presentation.

3. Build your course by replacing text and graphic placeholders with your content.
4.  When you are finished building your course, delete all the leftover slides.
To use the Rapid E-Learning Course Template for an existing course:
1. Open rapid_course_template.pot.
2. Copy the template slide you want to use.
3. Paste it into your course.

If you are using PowerPoint 2000, the newly inserted slide will
automatically adopt the slide master you are
currently using. ] Paste badge

If you are using PowerPoint 2002 or above, you
have the option of retaining the slide master of the
newly inserted slide or using the slide master of
your existing course. To choose either option:

A
1. Immediately find the Paste badge at the & -
edge of the inserted slide. It looks like a Keep Source Formatting
clipboard and will probably be at the (), Use Design Template Formatting
lower-right of the slide’s image. Click the ¥

Paste badge.

2. Select Keep Source Formatting from the menu if you want to keep the slide master of

the slide you are inserting, or select Keep Design Template Formatting if you want to
use your existing slide master. Adjust
spacing and colors as needed.

Btk ok G e e e B
IEEEIEEY

E e R T LT TR VT T

a Topic 3 preview

e — Each slide contains basic instructions on an

 bai port 1 orange note or callout. Follow the instructions and
S delete the note and/or callout. More tips and
suggestions are in the Notes field of each
individual slide.

m Main point 3,
Relevant graphic

Basic
instructions

j\l

Tips and
suggestions

5

Copyright © 2005 Articulate Global, Inc. All rights reserved.



a

Individual slides and notes

Here are the individual slides in the Rapid E-Learning Course Template
(rapid_course_template.pot). The notes to the right are the same as those in the notes field of the

PowerPoint template file.

Rapid E-Learning Course Template

How to use this template

Instructions are in /F="
the Notes field

(View > Normal) —

1| 1. View the course templates

in Slide Show mode

‘| 2. Duplicate slides you need

more of.

w

Delete the slides you do
not need.

~

Replace the placeholders
with your content,

5. Add additional content
slides as needed.

6. Delete the notes and other
instructions

Add narration.
8. Publish

This Rapid E-Learning course Template, designed
in conjunction with William Horton Consulting, is
provided to customers of Articulate to help you
rapidly build a simple e-learning course. This file
provides the structure. You provide the content. This
template is suitable for e-learning, classroom
training, as well general presentations.

To get started,

1. Play the template file in Slide Show mode (F5) to
see the built in animation effects.

2. Duplicate the slides of which you need more.
3. Delete the slides you do not need (like this one).

4. Replace the text and graphic placeholders with
your content.

5. Add additional content slides as needed.

6. Delete the notes and other instructions on the
slides.

7. Add narration.

8. Publish for delivery over the Web from the
Articulate menu in PowerPoint. We suggest your
player template include the navigation panel.

Course subtitle

Course title

Sponsoring Organization
v articulate cor

The Course title slide identifies the course. It helps
learners confirm that they have launched the right
course and motivates them to dive right into learning.

Replace the Course title placeholder with the official
name of the course. It should be the same as the
one the learner selected to launch the course.

In naming your course, strive for a short name that
clearly communicates what the course does for the
learner. Use terms that the learner will recognize
before completing the course.

Use the Course subtitle placeholder to elaborate on
the title. Make the subtitle up to three lines long.

Add any notices the learner should see before
continuing, for example, a safety warning or the
requirement for a security clearance.

6
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a Your instructor

Replace the
placeholder
with a
photograph of
the instructor
in action.

See the Notes area or
mor instructons.

Delels this caloutwhen
done,

Instructor’s Name

Title: Enter title or job role.

Accomplishments: What makes
the instructor qualified to present
this course.

Education: List degrees if
important.

Publications: Writings by the
instructor on the subject of the
course

Contact
instructor@someplace.com
+1.000.000.0000

People are naturally curious about people, especially
people they are asked to trust and rely on for their
own success. Use an introduction slide such as this
to:

» Put a face and a personality with the name of
instructor.

» Establish the authority and credibility of the
instructor and hence the course.

» Capitalize on the fame or reputation of the
instructor associated with the course.

Use a photograph that shows the instructor doing
something relevant, rather than the typical drivers-
license photo.

Edit the description at the right of the photo to
highlight the qualifications of the instructor. An
academic audience may be more impressed with
degrees and publications while an industry audience
may be more interested in successful projects and
awards.

Instead of the instructor, you might want to introduce
the course author, narrator, or subject-matter expert.

Course objectives

By completing this course, you will:

Relevant graphic

B This is the lead. And this is
the rest of the item

B This is the lead. And this is
the rest of the item

B This is the lead. And this is
the rest of the item

B This is the lead. And this is
the rest of the item

B This is the lead. And this is
the rest of the item

The Course objectives slide tells learners in detail
what they will get out of taking the course. Use this
slide to answer questions learners have about what
the course accomplishes and to provide motivation
for learners to complete the course. Tell people what
they will individually gain by completing the course,
without making a big deal about objectives.

Include a relevant graphic to show what learners will
be able to do after completing the course. You might,
for example, show an attractively styled report, a
smiling team, or a happy customer.

In the bullet list, tell learners what they will be able to
do (skill), come to understand (knowledge), or grow
to feel (attitude). Emphasize benefits that learners
will value. Ask yourself, “Can learners see how the
objectives make them healthier, wealthier, or wiser?”

If your learners are highly visual, consider replacing
the bullet list with a series of appropriate pictures
illustrating the outcomes you promise.

7
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K:‘ Topic 1 title

This is the subtitle

Fill in the
placeholder text.

The Topic title slide marks the start of a section of
your course. Use it like you might use a level-one
heading in a document.

The topic title should be sufficient to communicate
the topic’s contents to most learners.

Keep the title short and use the subtitle (up to three
lines) to elaborate on the title. A good subtitle will
imply what the learner gains in this topic.

If the topic accomplishes a specific learning
objective, you may want to imply that objective in the
subtitle.

If the actual content of your topic is short, only a
slide or two, you may want to omit this slide.

a Topic 1 preview

Optional subtitle that further explains the

® Main point 1
® Main point 2

® Main point 3.

Summarize the ideas of this
topic. Present more detail
through voice narration.

Give your topic a
meaningful title.

Use the subtitle to
further explain the
title.

Relevant graphic

The Topic preview slide prepares learners for the
topic. It provides a concise introduction and
overview.

Use the subtitle to further explain the title or to
introduce the bullet list. Or, delete the subtitle.

Summarize the main points of your topic using the
bullet list. Use voice narration to explain each bullet
item and to elaborate upon it.

Replace the graphic placeholder with a relevant
graphic to lock in the concept. The graphic could
show an example of the concept, a diagram of the
concept, or a formula for a relationship.

If your topic is very simple, you may want to omit this
slide.

If you are using a strategy of discovery learning, you
may want to move this slide to the end of the topic
where it serves as a summary.

a Topic 1 content

Replace this slide with
content slides from the
Content Starter Set that
communicate the ideas of

the topic.

The subject of your topic will determine what
additional slides you need. To help you, we have
included the accompanying Content Starter Set
template filled with animated diagrams, charts, and
tables.

Do not overwhelm learners with content or talk them
to sleep. Include just the content necessary to make
your point. Continually ask, “How does this slide
contribute to this topic?”

Remember, you are not limited to words and
graphics. Articulate Presenter makes it easy to add
Flash movies, Microsoft Word and PDF documents,
Web pages, and hyperlinks.

8
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a Topic 1 Stop-and-think

Replace this slide with a
rhetorical question slide, a
learning game, an Articulate
QuizMaker quiz, or a
combination of activities.

S0 the Notes area for mare instructios.

Use Stop-and-think slides to help learners lock in
the main ideas you have presented. A Stop-and-
think activity can take several forms:

Rhetorical question or decision. Ask the learner a
rhetorical question or require a simple decision. Use
one of the accompanying Content Starter Set slides
when you just want to help learners tie a new
concept to something they already know and do not
need to track learners’ scores. Also use this
approach when you do not want to interrupt the flow
of the lesson with a learning game or formal quiz.

Articulate learning game. Use one of the built-in
Articulate learning games when you want to help
learners lock in multiple, related concepts. Choose
from games, such as true/false, multiple choice, fill-
in-the-letter, and sequences. These games are timed
and can help reinforce knowledge.

QuizMaker quiz. Use an Articulate QuizMaker quiz
when you want to formally measure a learner’s
understanding. QuizMaker quizzes are scored and
results can be recorded to a learning management
system, Articulate Knowledge Portal or Articulate
Online. Multiple question types are available. The
Quiz slide, near the end of this file, suggests when to
use the various question types.

The set of four topic slides is repeated twice more.

() Course summary
'@
@ 5

Fifth ltem
(el [ First Item

O bad

Third Item
Second Item

Use the Course summary slide to recap the most
important points of the course. Keep the points short
and easy to remember.

Summarize the content in short sentences or
phrases. If a summary item is more than a few lines
long, left align its text.

Compare your Course summary slide to your
Course objectives slide. The summary should not
just restate the objectives, but should contain the key
points necessary to accomplish those objectives.

If you have more than five or six important points,
consider breaking the course into multiple courses or
reducing the coverage of the course

9

Copyright © 2005 Articulate Global, Inc. All rights reserved.



a

@ Quizintroduction

What the quiz covers

Required?
Graded?

Number of questions

Yes or No

Yes or No

Fill in these cells as
appropriate.

nn points per question
nn points or nn percent correct

The Quiz introduction slide announces the course
quiz and provides information the learner needs to
begin the quiz. This slide covers the rules specific to
the individual quiz.

If you decide to use a QuizMaker quiz at the end of
each topic (in place of a rhetorical question or
learning game), you may wish to include one of
these slides to introduce the quiz. In that case, use
the [What the quiz covers] placeholder to tell
learners whether the quiz covers just material in the
current topic or everything up to that point in the
course

@ Quiz

Replace this slide with a

QuizMaker Quiz.

See the Notes area for more instruc

tions

Insert an Articulate QuizMaker Quiz here. Because
QuizMaker will insert its own placeholder slide, you
should delete this slide before publishing the course
in Articulate Presenter.

With QuizMaker you can insert quizzes with multiple
questions. Examples of question types include:

True/False. To test learner’s ability to make
categorical judgments and to pick between true
opposites. Also use true/false questions to simulate
job activities that require yes/no, go/no-go,
approve/disapprove, or pass/fail kinds of decisions.

Multiple Choice. For activities that require learners
to assign items to well-defined categories, for
questions with one right answer, or where
recognition, not recall, is the goal.

Multiple Response. For sophisticated questions
with more than one right answer. Also use them to
test the ability to make precise discriminations.

Fill-in-the-Blank. Where the correct answer
depends on context, where learners need
scaffolding, and where correct spelling is important.
Also use fill-in-the-blank questions to test
incremental learning by having learners fill in the
most recently learned parts.

Matching. To measure knowledge of the
relationship among concepts or objects, like tools
and their uses, terms and their definitions, etc.

Ranking. To measure a learner’s ability to arrange
information in a sequence or ranking, such as steps
in a procedure or phases in a process.

10
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For more

If you want to go into these subjects more deeply, ...

Picture of

book cover

List additional courses in

take

URL to obtain book.

www.articulate.com

www.horton.com

or other meetings

www.google.com

your curriculum learners can

List appropriate conferences

Use the For more slide to provide learners with
suggestions on how to continue learning about the
subject of this course.

Add or remove elements as needed. If you add
additional elements, such as images or text,
remember to give each element a Fade or some
other animation effect.

Also consider referring learners to job-aids, online
discussion forums, blogs, knowledge bases, help
desks, Webinars, and other sources of knowledge.

To make links open referenced Web sites:

1. Select the text you want as a link.

2. Select Insert > Hyperlink or type Ctrl-K.
3. Enter the Web address in the Address field.
4. Click OK.

Congratulations

You have successfully completed
the course

name-of-the-course

Insert the name of the

the name-of-your-orgar.  course and the name of
the sponsoring
organization.

A Delete this calout when done.

=

Congratulate learners and leave them with a warm
feeling and a sweet taste upon successfully
completing the course.

Here is an idea: Prepare a real certificate in
Microsoft Publisher or other program and save it as
an Adobe PDF document. Then, provide a hyperlink
on this slide that learners can click to open the PDF
document. From the Adobe Acrobat window, they
can print the certificate to their local printer.

Or...

If learners log in to an LMS to access your course,
then you may be able to pair that log-in information
with the learner’'s name and dynamically insert the
name into a placeholder in the certificate. You will
need to talk with your LMS administrator to see what
is possible. Also, if your company uses Articulate
Knowledge Portal, customized certificates with
dynamic fields are a built-in feature.

11
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CONTENT STARTER SET

The Content Starter Set (content_starter_set.pot) template contains various types of content
slides to use within the Rapid E-Learning Course Template slides. There are tables, diagrams,
graphs, and stop-and-think activities. Replace the text and graphic placeholders with your own
content, add narration, then publish for e-learning delivery.

Organization

Here are the slides included in the Content Starter Set. Notice that many of the template slides
also have an example to illustrate how you might use the template in your courses. They are
shown next to the template in the following table. They occur after the template in the slide file.

Lists and blocks of text

Multi-level bullet list

The Multi-level bullet list template is an animated bullet list of
three levels of items. Use it to present a complex, structured
list where you want to focus attention to items one at a time. In
this animated bullet list, each line wipes on in response to a
mouse click.

Multi-level bullet list

B [ Checklist

The Checklist template is a simple animated list with
checkboxes instead of solid bullets. Use it to present a simple
list of choices or tasks to perform.

e How-to procedure

§ s P Use this template when you need to explain
S = ﬁ a procedure involving a physical object.
e i

0 e Definition

Use this template to spell out the meaning of crucial terms
such as the names of concepts, principles, products,
procedures, and organizations.

O Quotation
Use the Quotation template to present memorable words of an
S authority or celebrity

O BEEREn srakoc o Abbreviation spelled out
Q Use this template to introduce acronyms and other
£ abbreviations.
E
12
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Ol Note
e Use this template to present something to which the group
S o8 should pay close attention.

(D Example: Retum on investment

Tables

B3 Example: Project background

3 Table (3.x 5 with row heads Example;Classity rocks by rock ype

Animated charts and diagrams

3 Labeted

hic B Example: Time machine

3 Phase timeline (3 phases) B3 Example: Blended learning

Calculation
Use this template where you want to show a
mathematical calculation.

Table (1x5) with row heads

This animated table contains one column for
labeling rows and one additional column for
data.

Table (3x5) with row heads
This animated table contains one column for
labeling rows and three additional columns.

Table (2x7) with animated arrows

An arrow connects entries in the left column
to those in the right. After the headings
appear, each row appears. First the left cell
appears and then, after another mouse click,
an arrow leads the eye to the right column.

Levels bottom up

This template builds levels from the bottom
up to communicate the notion that higher
levels are more powerful, valuable, or
sophisticated than lower ones.

Labeled graphic
Use this template to identify the parts or
areas of a scene.

Arrow timeline
Use the Arrow timeline template to talk about
a project spanning weeks or months.

Phase timeline (3 phases)

This template shows events or tasks during
a procedure, process, or project of three
phases.

13
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B Pyramia

B3 Example: Technology team

3 Aveas on a 20 graph (¢ and )

3 Exampl: immunity and immunization

Cycle chart (2 phases)

Use this template for a two-phase effort that
repeats itself, for example, production and
consumption.

Cycle chart (4 phases)
Use this template for a four-phase effort that
repeats itself.

Pyramid

Use this template to show a pyramidal
hierarchy. The implication of this template is
that power is at the top and there are more
people and activities at the bottom. Also that
upper layers somehow depend on lower
ones.

Venn diagram

Use this template to show overlapping
categories. It shows relationships among
separate ideas, terms, or zones of influence.

Left-versus-right scale

Use this template to narrate a continuum
between two extremes. Use it to explain that
a choice is not a simple either-or choice. Use
this template to offer advice on making
complex decisions.

Areas on a 2D graph

This template shows areas situated along
two axes. Use it to sort out categories along
two axes or to clump data into categories.

Areas on a 2D graph (+ and -)

This template shows areas situated along
two axes spanning both positive and
negative values. Use it to sort out categories
along two axes or to clump data into
categories.

Syntax of a line of text
Use this template to elaborate on the
components of a line of text.

Taxonomy chart—top down

Use this template whenever you want to
classify objects into increasingly broader
categories.
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B3 Flowchart B3 Example: Picking an order Flowchart

T Use this template when you want to show
the sequence, cycle, or flow of a series of
activities. If the flow is complex, consider
using multiple slides to depict it.

z[!@!-@ﬁ

Short-answer fill-in blanks

Use this template to prompt learners to
provide multiple answers to a single
question.

\
vyvyvyYVYYy

Multiple-choice question
Use this template to present a multiple-
choice question to learners.

B Matching items n two ists

Matching items in two lists
Use this template to test learners’ ability to
associate items from two lists.

Emblems, icons, and scheme colors

a

2
3
]

Emblems and icons
Use these slide emblems and icons to help signal the type of
information you are presenting.

3

2

Q
a
a
a

..
(<)

0808UETO §

V]
o
i
3
H

Scheme colors
These are the scheme colors for the E-Learning Rapid-
Development slide template.

General instructions

To add a Content Starter Set slide to a course or presentation:
1. Open content_starter_set.pot.
2. Select the thumbnail of the slide you want and Copy it.
3. Paste it into your course.

If you are using PowerPoint™ 2000, the newly inserted slide will automatically adopt the slide
master you are currently using.

If you are using PowerPoint™ 2002 or above, you Phase tmeline (3 phases)
have the option of retaining the slide master of the Sl - W oo Paste badge
newly inserted slide or using the slide master of your hImo fES | bES

existing course. To choose either option:

1. Immediately find the Paste badge at the
edge of the inserted slide. It looks like a z

clipboard and will probably be at the lower- PR

% Use Design Template Formatting
¥
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right of the slide’s image. Click the Paste badge.

2. Select Keep Source Formatting from the menu if you want to keep the slide master of
the slide you are inserting, or select Keep Design Template Formatting if you want to
use your existing slide master. Adjust spacing and colors as needed.

Each template slide contains basic instructions,
tips, and suggestions in the Notes field of each
individual slide.

1. Task one.

2. Task two

L. . Basic
instructions
For many of the template slides, there are e

examples showing how you might use the
template. Look in the Notes field of these
examples to see what steps were taken to modify .
the template to create the example.

Example: Blended learning

corn [l ceanes
. Openness

1. Disputes are
destructive

(case studies)

2. Listening
objectively

Instructions for
customizing the template.

16
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